Chapter 2

Creating Projects
and P&IDs

Learning Objectives

After completing this chapter, you will be able to:
¢ Create a new project

* Create a new drawing

* Create a P&ID drawing

* Add an equipment to a P&ID

* Assign a tag to a line

* Add valves

* Add instruments and instrumentation lines

* Add fittings

* Add off-page connectors

* Validate the P&ID drawing

* Edit the drawing

* Substitute components

* Convert AutoCAD components into P&ID Symbols
* Work with the Project Setup dialog box
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INTRODUCTION

In this chapter, you will learn how to create a new project and a new drawing. Also, you will be
briefly introduced to the P&ID module.

PROJECT MANAGER

The PROJECT MANAGER is used to access 1 PROJECTMANAGER

. e . . Current Project:

existing projects, create new projects, add new :
. . . Default Project ~ | .
drawings to a project, re-order drawing files, and , ) T
. . . . . . Project Qe - =
modify the existing 1nformat10n in a project. It zlilso . o :

allows you to export and import data, create project LR

reports, include referenced drawings (xrefs), and link d-{f) PeuD Drawings -
or copy files to the project folders. By default, the " E:;':;Deimw'”gs E
PROJECT MANAGER is docked on the left of your =D Related Files g
S

screen. Figure 2-1 shows the PROJECT MANAGER.

The PROJECT MANAGER contains three tabs:

=
Source Files, Orthographic DWG, and Isometric Detaib ERE E
DWG. The Source Files tab contains a project tree Project XMLi C\Users\CADCINAppDatatoam | 5
that displays P&ID drawings, Plant 3D drawings, Proec et
Pipe Specs, and all related files of the project. The o e T e
Orthographic DWG tab contains the list of all the Project number:
orthographic drawing files. The Isometric DWG
tab contains the isometric line diagrams of the plant
layout. < >

CREATING A NEW PROJECT Figure 2-1 The PROJECT MANAGER
IN AutoCAD Plant 3D

To create a new project, choose the New Project option from the drop-down in the Current
—  Project area of the PROJECT MANAGER. You can also create a new project by choosing
the New Project option from the Project Manager drop-down list of the Project panel in the
Home tab; the Project Setup Wizard with the Specify general settings page will be displayed,
as shown in Figure 2-2. Alternatively, use the NEWPROJECT command to create a new project.
Steps to create a new project are discussed next.

1. Enter a project name in the Enter a name for this project edit box. Next, enter a description
of the project in the Enter an optional description edit box.

2. Choose the Browse button adjacent to the Specify the directory where program-generated
files are stored edit box; the Select Project Directory dialog box will be displayed. Browse
to the directory C:\Users\user_name\Documents and choose the Open button; the location of
the project is automatically displayed in the edit box.
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A Project Setup Wizard (Page 1 of 6

Specify general settings

Enter & name for this project:
[Project 1 |

Enter an optional description:

Vault folder path:

Create this project in vault:

Specify the directory where program-generated files are stored:
[coUsers\CADCIM Documents |

[[] Copy settings from existing project From vault server
Select project XML file:

= ==

Figure 2-2 The Project Setup Wizard with the Specify general settings page

3. Clear the Copy settings from existing project check box, if selected, and then choose the
Next button; the Specify unit settings page will be displayed, as shown in Figure 2-3.

A Project Setup Wizard (Page 2 of §) X

Specify unit settings

Specify the base unit for project drawings
(®) Imperial
All units-based properties are reported in inches
() Metric
Mast units-based properties are reported in millimeters

Report nominal diameters of imperial content in:

Millimeters Inches (Mixed Metric)

|<<Back|‘Ned>>||Ca\cd

Figure 2-3 The Specify unit settings page

4. Choose the Imperial radio button, if not chosen by default, and then choose the Next
button; the Specify P&ID settings page will be displayed, as shown in Figure 2-4.
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A Project Setup Wizard (Page 3 of 6) X

Specify P&ID settings

Specify the directory where P&ID drawings are stored:
[c\Users\CADCIM\Documents \Project 1\PID DWG | [ =]

Select the P&ID symbology standard to be used:
PIP
ISA

Mote: All symbols will be drawn in inches.

| <Back | Nems> | | Cancel

Figure 2-4 The Specify P&ID settings page

5. Specify the directory as C:\Users\user_name\Documents\users_project\PID DWG in the
Specify the directory where P&ID drawings are stored edit box by using the Browse
button available next to this edit box.

6. Select PIP as the P&ID standard from the Select the P&ID symbology standard to be used
list box and choose the Next button; the Specify Plant 3D directory settings page will be
displayed, as shown in Figure 2-5.

A Project Setup Wizard (Page 4 of 6 X

Specify Plant 3D directory settings

Plant 3D model DG file directory:
|C:\Users\CADCIM\Documents\Project T\Plant 30 Models |

Spec sheets directory:
[c:\Users\CADCIM Documents'\Project 1\Spec Sheets | =]

Orthographic output directory:
[c:\Users\CADCIMNDocuments \Project 1\Orthos\DWGs | T

Specify the directory where supporting files (such as spreadsheets or \word documents) are stored:
|cUsers\CADCIMNDocuments\Project 1\Related Fies | =]

| <Back | | New» | | Cancel |

Figure 2-5 The Specify Plant 3D directory settings page
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7.

10.

11.

12.

13.

Note
In this book, the Imperial standard has been used throughout.

Accept the default settings in this page and choose the Next button; the Specify database
settings page will be displayed, as shown in Figure 2-6.

A Project Setup Wizard (Page 5 of 6) x

Specify database settings

§ X Help me choose
@® 1 Single User - SQLite local database
Use this file based solution to quickly try out a project with 1 or 2 team members.

(O 228 Multi-User - SQL Server database (Recommended)
Use this solution for production projects with several team members.

SQL Server name:

Database name prefix:

Authentication:
Windows Authentication

User name: Password:

Do you have an existing project that you would like to convert to SQL Server? Learn More

<< Back Neut >> Cancel

Figure 2-6 The Specify database settings page

In this page, select the option to specify the database settings. Select the Single User - SQLite
local database radio button, if you are working on a stand-alone system.

Note that you need to skip Steps 9 through 11, if you have selected the Single User - SQLite
local database radio button.

If your system is connected to a server, select the Multi User - SQL Server database radio
button. Next, you need to specify the server name in the SQL Server name edit box and
then choose the Test Connection button next to it.

After connecting to the server, you need to enter a database prefix in the Database name
prefix edit box. You can also choose the Test Name button to automatically generate a
prefix.

Next, specify the authentication type by using the Authentication drop-down list. If you
select SQL Server Authentication, you need to specify the user name and password in the
User name and Password edit boxes, respectively.

After specifying the database settings, choose the Next button; the Finish page will be
displayed.

Choose the Finish button; a new project will be created and listed in the PROJECT
MANAGER.
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Creating a New Drawing

To create a new drawing, first select the node (For example: P&ID Drawings) from the PROJECT
MANAGER. Next, choose the New Drawing button from the Project toolbar, as shown in
Figure 2-7; the New DWG dialog box will be displayed, as shown in Figure 2-8. In this dialog
box, enter the file name, author, and then select a dwg template by choosing the Browse button
next to the DWG template edit box. Choose the OK button; a drawing file with the specified
name will be created.

i PROJECT MANAGER
Current Project:
Project 1 ~ | = -
o
Project i ¥s I
search =
} Mew Drawing

=-T% Project 1

P&ID Drawings

--ﬁ';, Plant 30 Drawings

-- Pipe Specs
@[ Related Files

o
wgraphic DyWWG |—F

Figure 2-7 Choosing the New Drawing button

A New DWG x

Drawing name

File name:

[ldwg

Drawing properties
Author:

CADCIM

Project properties
Folder path:

|C:\Users\CADCIM\Documents* Project 1\PID DWG |

DG template:
|PID ANSI D Color Dependent Plot Styles.dwt |

Corcel | [ Help

Figure 2-8 The New DWG dialog box

Grouping Project Files

You can group drawings into a folder. This ensures that the folder path retains the same
folder hierarchy, even if the project files are moved to another computer. To do so,
right-click on the required node (for example P&ID Drawings node) in the PROJECT
MANAGER and choose the New Folder option from the shortcut menu displayed; the New
Folder dialog box will be displayed, as shown in Figure 2-9. Next, enter a name in the Folder
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name edit box. Now, choose the OK button; the new folder will be added to the P&ID Drawings
node in the project tree. Click and drag the drawing file to the newly created folder to move
the file, refer to Figure 2-10.

A New Folder X

Folder name:

Folder path:
[C:\Users\CADCIM-CAD Team'\Documents\Project 1'PID DWG |

DG creation template for folder:
[PID ANSI D Color Dependent Plot Styles.dwt |

[] Promgt for template

Concd | [ Hib

Figure 2-9 The New Folder dialog box

§ PROJECT MANAGER
Current Project:

[ project M= =R
=
Project Qslad - 3
search Q, é

=-% Project 1

£~ P&ID Drawings

5.0 P&ID 4
i ~[3 Drawing! %;
[ ofg
-0 P&ID2

[ Plant 30 Drawings

Orthographic DWG

Figure 2-10 Dragging the drawing file into
the folder

DESIGNING A P&ID

A P&ID is a graphical representation of a plant process and is created by combining various
types of components, pipings, and instrumentations that are required to design, construct, and
operate the plant. To design a P&ID, you need to create a new P&ID drawing file. The procedure
to create a new drawing file is explained earlier. After creating a P&ID drawing file, the 3D
Piping environment will be displayed by default, refer to Figure 2-11.

The TOOL PALETTES, which is available at the right side of the window, is also loaded with
modeling components. In order to display P&ID environment and P&ID components in the
TOOL PALETTES, choose the Workspace Switching button available in the right side of
the Status Bar; a flyout will be displayed. Choose the PID PIP option from the flyout, refer to
Figure 2-12; the P&ID PIP environment will be displayed and the TOOL PALETTES will be
loaded with P&ID components, as shown in Figure 2-13.
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Figure 2-11 The P&ID environment

3D Piping
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PID IS0
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Save Current As...
Workspace Settings...
Customize...

Display Workspace Label

Figure 2-12 Choosing the PID PIP option

Sfrom the flyout

Adding Equipment to a P&ID

Equipment includes all the components that are associated with the process plant such as pumps,
heat exchangers, compressors, blowers, tanks, vessels, and so on. To place an equipment in a
P&ID, first you need to check whether the TOOL PALETTES - P&ID PIP is displayed or not.
If it is not displayed, choose the Tool Palettes button from the Palettes panel in the View tab;
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Figure 2-13 The TOOL PALETTES
loaded with P&ID components
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the TOOL PALETTES - P&ID PIP will be displayed on the right side of the window. In the
TOOL PALETTES - P&ID PIP, choose the Equipment tab; the symbols of various equipments
will be displayed in it. Choose the symbol of the desired equipment from the TOOL PALETTES;
it will be attached to the cursor and you will be prompted to specify the insertion point. Click
in the drawing area to place the symbol; the Assign Tag dialog box will be displayed, as shown
in Figure 2-14.

A Assign Tag hed

Class: Pumps
Tag Format: Equipment Tag [Type-Number]

Type

[] Place annotation after assigning tag

Annotation style: | Equipment Tag

Assign Cancel Help

Figure 2-14 The Assign Tag dialog box

Note that in some equipments after clicking in the drawing area to place the symbol, you will
be prompted to enter the XY scale factor. You can scale the equipment horizontally or vertically
by dragging the cursor in the respective direction. Alternatively, you can enter a scale factor at
the command prompt.

In the Assign Tag dialog box, enter a numeric value in the Number edit box and select the
Place annotation after assigning tag check box. Next, choose the Assign button; the Assign
Tag dialog box will be closed and you will be prompted to select the annotation position. Place
the annotation below the equipment at an appropriate location.

Adding Pipe Lines

You can select a line from the Pipe Lines area in the Lines tab of the TOOL PALETTES - P&ID
PIP. For example, to connect a vessel and a condenser with a primary line, choose the Primary
Line Segment tool from the Pipe Lines area in the Lines tab of the TOOL PALETTES - P&ID
PIP; you will be prompted to select the start point. Select a point on the top of the vessel. Next,
connect the line to the top nozzle of the condenser, as shown in Figure 2-15; a nozzle will be
created automatically on the vessel and an arrow will show the direction of flow. Note that the
direction of flow is determined by the direction in which you move the cursor while creating
the line.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 2-15 Schematic line connecting the vessel
and the condenser

You can easily distinguish between a line connected to a component and a line which is not
connected. On selecting the line that is connected to a component, a connection grip is displayed
at the end of the line, as shown in Figure 2-16. But if the line is not connected to a component,
an end grip is displayed at the end of the line, as shown in Figure 2-17.

e S S 3-‘“%%* ------------- % |
*“5: .\ Connection \

grip End grip

Figure 2-16 A connected line showing the Figure 2-17 A line not connected to any
connection grip line or a component

/ Note

@ After connecting two components with a pipe line, the From’ and 10’ information is automatically
added to the line. This information is displayed when you hover the cwrsor over the line. The
From’ field shows the component from which the line originates and the ‘10’ field indicates the
destination component.

Assigning Tags to a Line

After creating a line, you need to assign a tag to it. The tag data consists of the information such
as pipe size, specification, service, and line number; refer to Figure 2-18 for the representation
of tag data on the line. In order to assign a tag to a line, choose the Assign Tag tool from the
P&ID panel in the Home tab and select a line. Next, press ENTER; the Assign Tag dialog box
will be displayed. Enter the data in the respective edit boxes and choose the Assign button; the
tag data will be assigned to the line. Also, you can select the Place annotation after assigning
tag check box from the Assign Tag dialog box in order to place the annotation near the line.
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Spec Service

Size —‘ ’— Line number

8”—CS150-F0—10003

-

Figure 2-18 Annotation of a pipeline tag

Assigning Custom Service Category to a Line

As discussed earlier, after creating a line, you need to assign a tag to it. By default, you can assign
pipe size, specification, service, and line number to a line. While assigning the service category
to a line, the required service category might not be available in the Pipe Line Group.Service
drop-down list of the Assign Tag dialog box. You can add the required service category to the
Pipe Line Group.Service drop-down list using the Project Setup dialog box. Let us suppose
you need to add Sludge Line service to the list. The procedure to add the Sludge Line service
is given next.

Choose the Project Setup tool from the Project Manager drop-down of the Project panel in the
Home tab; the Project Setup dialog box will be displayed. In this dialog box, expand the P&ID
DWG Settings node. Next, expand the P&ID Class Definitions sub-node and then choose the
Pipe Line Group option available under the Non Engineering Items; the corresponding options
will be displayed in the Properties area of the dialog box, refer to Figure 2-18(a).

x

i

[mijmjjmimimimjmimiy=

po. [ Tag Sting
pro...| e Number Sting

EENEEENEg

No preview available

serly Coneel elp

Figure 2-18(a) The Project Setup dialog box with
the Pipe Line Group option chosen

In the Properties area, select the Service option available under the Property Name column.
Next, choose the Edit button available at the right in the Properties area; the Selection List
Property dialog box will be displayed, refer to Figure 2-18(b).
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A Selection List Property
Mame:
[Service (PaID) |
Pipe_Sizes Value Description ~
Pipe_Specs
Tracing_Types ATMOSPHERIC VENT
Insulation_Types
Instrument. Types BA BREATHING AIR
BD BLOWDOWN
Equipment_Types
Status BFW BOILED FEED WATER
ERR BRINE RETURN
BRS BRINE SUPPLY
cC CONTAMINABLE COND..
CF COLD FLARE
CHS CHEMICAL SEWER
cv COLD VENT
CWR COOLING WATER RET...
cws COOLING WATER SUP
DMwW DEMINERALIZED WAT...
Add List.
DR DRAIN
Remove List DS DILUTION STEAM v
Conce

Add Row...

Delete Row

Help

Figure 2-18(b) The Selection List Property dialog box

In this dialog box, the Services option is chosen by default, refer to Figure 2-18(b). Now, choose
the Add Row button; the Add Row dialog box will be displayed. Enter SL in the Value edit box
of the dialog box, refer to Figure 2-18(c) and then choosse the OK button; the new value SL will
be added to the Value column of the Selection List Property dialog box. Select the newly added
value SL from the Value column and then enter SLUDGE LINE in the respective Description

edit box, refer to Figure 2-18(d) and then choose the OK button.

A Add Row

Walue:

*

e

Description:

Cance

Figure 2-18(c) The Add Row dialog box
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A Selection List Property

Mame:
[Service (PaID) |

Fipe_Sizes Value

Description

Pipe_Specs

Tracing_Types RV RELIEF VENT
Insulation_Types
Instrument_Types RW RAW WATER
sC STEAM CONDENSATE
Equipment_Types
Status 5G SYNTHESIS GAS
5L SLUDGE LINE]
50 SEALOIL
55 SANITARY SEWER
5TS STORM SEWER
5w SERVICE WATER
SWR SEAWATER RETURN
SWS SEAWATER SUPPLY
TWR TEMPERED WATER RE
TWS TEMPERED WATER 5U...
Add List
VC VACUUM CONDENSATE
e VE VACUUM EXHAUST
Cone

Add Row...

Delete Row

Help

Figure 2-18(d) The new value SL added to the dialog box

Next, choose Apply and then the OK button to exit the Project Setup dialog box; the new
service category SL - SLUDGE LINE will be added to the Pipe Line Group.Service drop-down

list of the Assign Tag dialog box.

Creating and Adding Custom Pipe Line Segments to TOOL

PALETTES

You can create custom pipe line segements and add them to TOOL PALETTES. To do so,

choose the Lines tab in the TOOL PALETTES. Next, invoke the Project Setup dialog box. In

this dialog box, expand the P&ID DWG Settings node. Next, expand P&ID Class Definitions >

Engineering Items > Lines > Pipe Line Segments sub-nodes. Next, click on the Pipe Line
Segments sub-node and right click on it; a shortcut menu will be displayed. Choose the New

option from the shortcut menu; Create Class dialog box will be displayed, refer to Figure 2-18(e).

Create Class

Class Name:

*

Display Name of the Class:

Cancel

Help

Figure 2-18(e) The Create Class dialog box

Enter Sludgeline in the Class Name edit box and Sludge Line in the Display Name of the Class
edit box. Choose the OK button; the Sludge Line will be added and highlighted under the Pipe

Line Segments sub-node. Next, choose the Edit Line button available in the Line area of the
Project Setup dialog box; the Line Settings dialog box will be displayed, refer to Figure 2-18(f).
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A Line Settings X
Symbol Properties -
Show flow a.. Ne
Flow arrow ... | Flow Arrow Style
General Style Properties -
Layer ---- Use Current ----
Color ---- Use Current ----
Sline type Polyline
Linetype Continuous
Linetype Scale |-—- Use Current -——-
Plotstyle o
Lineweight  |---- Use Current ----
Other Properties -

Tagging pro... Notatagged component
Gap priority |0

Cancel Help

Figure 2-18(f) The Line Settings dialog box

Choose the Yes option from the Show flow arrows drop-down. Next, assign the Layer, Linetype,
Color, Lineweight, Tagging prompt, Gap priority value and so on from the respective drop-downs.
Choose the OK button to exit the dialog box. Next, choose the Add to Tool Palette button from
the Line area of the Project Setup dialog box; the Create Tool message box will appear. Choose
the OK button from the message box; the Sludgeline will be added to the Line tab of the TOOL
PALETTES. Next, choose Apply and then the OK button to exit the Project Setup dialog box.

Adding Custom Tags to Pipe Line Segments

As discussed earlier, after creating a line, you need to assign tag to it. By default, you can assign
pipe size, specification, service, and line number to a line. In some cases, you might want to
assign other tag properties to the pipe segment like zone number, material of the pipeline,
slope, and so on.

Let us assign the size, zone number, material of the pipeline, and slope to the Primary
Line Segment available in the Pipe Lines area of the Lines tab in the TOOL PALETTES.
To do so, invoke the Project Setup dialog box. Expand the nodes P&ID DWG Settings >
P&ID Class Definitions > Engineering Items > Lines > Pipe Line Segments. Next, select
the Primary Line Segment option; it will be highlighted and corresponding options will be
displayed in the Properties area of the dialog box. Click on the Add button in this area; the
Add Property dialog box will be displayed, refer to Figure 2-18(g).
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A Add Property X

Property name:

Display name:

Choose a type
(®) String

() Numeric

() Boclean

() Selection List

() Acguisition

Cance

Figure 2-18(g) The Add Property dialog box

Enter Zone_Number in the Property name edit box and click on the OK button; the property will
be added to the Properties area. Similarly add material and slope properties to the Properties
area.

Choose the New button from the Tag format area of the dialog box; the Tag Format Setup
dialog box will be displayed, refer to Figure 2-18(h).

A Tag Format Setup >

Class: Primary Line Segment
Format Name: ||

Number of Subparts: |1 =

Field Delimiter

6| E8] &) [&] |

More ==

Cancel Help
Figure 2-18(h) The Tag Format Setup dialog box

Enter Pipeline Tag[Size- Zone Number- Material- Slope] in the Format Name edit box and
4 in the Number of Subparts edit box; the Tag Format dialog box will be modified, refer to
Figure 2-18(i).
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A Tag Format Setup X

Class: Primary Line Segment

Format Name: | ag[Size- Zone Number- Material- Slope]

Mumber of Subparts: 4[5

Field Delimiter

I@IIE::::HEH

l@lll:l (B
2 ]

Cancel Help

Figure 2-18(i) The modified Tag Format
Setup dialog box

Click on the Select Class Properties button, the first button in the first row; the Select Class
Property dialog box will be displayed, refer to Figure 2-19(j).

A Select Class Property X

Class: Property:

[=- Engineering ftems Class Name

(=)- Lines Description

[ Pipe Line Segments Manufacturer

Model Mumber
Supplier
Comment
Flag
Status
ParamOnLine
Size
Spec
Tracing
Insulation Type
Insulation Thickness
Paint Code
To
From
< » Operating Temperaturs hd

Primary Line Segme

Use Target Object’s Property

Carcel | Help

Figure 2-18(j) The Tag Format Setup dialog box
Choose the Size option from the Property list box and then choose the OK button. Similarly,
add Zone_Number, Material, and Slope to the remaining rows of the Tag Format Setup dialog
box, refer to Figure 2-18(k).

A Tag Format Setup >

Class: Primary Line Segment
Format Name: ‘I’ag[S\ze- Zone Number- Material- Slope]‘

Number of Subparts: |4 |+

Field Delimiter

A |E| |TargetObject Size | [ |
e [TargetObject Zone_Number | [- |
e [TargetObject Matenal I F |

More >

0OK Cancel Help

Figure 2-18(k) The Tag Format Setup dialog box
with class properties added
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Choose the OK button to exit the Tag Format Setup dialog box. Next, scroll down to the
TagFormatName row of the Properties area and then choose the Pipeline Tag[Size- Zone
Number- Material- Slope] option from the drop-down list in the Default Value column. Next,
choose Apply and then the OK button to exit the Project Setup dialog box; the newly created
tag format will be assigned to the Primary Line Segment.

Now, create a Primary Line Segment and then choose the Assign Tag tool to assign tag to it;
the Assign Tag dialog box will be displayed with the new class properties listed in it, refer to
Figure 2-18(1).

A Assign Tag X

Class: Pipe Line Seoments
Tag Format: Pipeline Tag[Size- Zone Number- Material- 5.

—

Slope:

[] Place annotation after assigning tag

Annotation style: | Pipeline Tag

Assign Cancel Help

Figure 2-18(1) The Assign Tag dialog box
with new tag format

Adding Valves

The Valves tab in the TOOL PALETTES - P&ID PIP contains

a group of valve symbols. You can add any type of valve to

a schematic line. For example, to place a gate valve on the

schematic line, you need to choose the Valves tab from

TOOL PALETTES - P&ID PIP and then choose the Gate >
Valve tool from the Valves area; the valve symbol will be

attached to the cursor and you will be prompted to select HA—101
the insertion point. Select an insertion point on the line;
the valve will be placed on the specified point, as shown in Figure 2-19 A gale valve placed

Figure 2-19. on the line
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Adding Instruments and LIl
Instrumentation Lines 5| Control Valve
Instruments play a major role in maintaining the safety and 5 i

streamlining the process in the plant. The Instruments tab in
the TOOL PALETTES - P&ID PIP contains Control Valve,
Relief Valves, Primary Element Symbols (Flow), General
Instruments, and Miscellaneous Instrument Symbols areas. 7N 52 e %
Figure 2-20 shows various instrument symbols available in the

Relief Valves

Equiprnent

Instruments tab. E 1:%1 m
For example, to add a control valve, choose the Control Valve

tool from the Instruments tab; the Control Valve Browser dialog & Primary Element Symbols (Flow)
box will be displayed, if you are adding a control valve for the =

!
first time. Select the required valve body from the Select Control | ! | IE‘ [g]

Valve Body tree view. Next, select the actuator type from the g E m m =
Select Control Valve Actuator tree view, refer to Figure 2-21 and g
choose the OK button; the dialog box will be closed and you = [=] ] =7 []
will be prompted to select an insertion point. Select an insertion E
point on the line; the control valve will be added and you will 3 @ m m o
be prompted to select annotation position. s
W B
f Note .
@ If the Control Valve Browser dialog box is not displayed, 55;;122Zjﬂé@iﬁ:ﬁfﬁ;gg%f

choose the Change body or actuator option from the
command bar to change the actuator of the valve body.

A Control Vahve Browser x
Select Control Valve Body: Select Control Valve Actuator:
[=)- Engineering tems - [=)- Non Engineering ttems s
- Inline Assets - Actuators
(- Hand Valves - Back Pressure Regulator
- Angle Valve - Back Pressure Regulator With Eder
- Ball Valve
- Butterfly Valve - Diaphragm Actuator
- Check Valve - Differertial Pressure Reducing Regul
- Diaphragm Valve - Electra-Hydraulic
- Diverter Valve - Hand Wheel Actuator
- Excess Fow Valve - Manual Actuator
- Four Way Valve - Posttioner And Solenoid
- Gate Valve - Pressure Balanced Diaphragm Actua
- Generic Rotary Valve - Pressure Reducing Regulator
- Globe Valve - Pressure Reducing Regulator With E
- Knife Valve - Rotary Motar
- Needle Valve - Solenoid
- Pinch Valve - Solencid Manual Reset
- Plug Valve - Solencid Remote Reset "
- Ratary Valve v < >

Carcal | [ iy

Figure 2-21 The Control Valve Browser dialog box

Move the cursor and click to position the annotation; the Assign Tag dialog box will be displayed.
Enter values in the Area, Type, and Loop Number edit boxes, and clear the Place annotation
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after assigning tag check box. Next, choose the Assign button from the Assign Tag dialog box;
an annotation bubble will be placed at the specified location.

After adding the control valve, you need to add the signal lines connecting the instruments and
the process line. Figure 2-22 shows various instrument lines used in a P&ID. For example, to
add an electrical signal, choose the Electric Signal line from the Instrument Lines area in the
Lines tab; you will be prompted to select the start point. Select the point on the process line;
you will be prompted to select the next point. Move the cursor toward left and connect the line
to the control valve.

Next, you need to place control instruments on the signal lines. For example, to add a temperature
controller, choose the Field Descrete Instrument tool from the General Instruments area of the
Instruments tab in the TOOL PALETTES; you will be prompted to specify the insertion point.
Select a point on the signal line connecting the control valve; the instrument will be placed and
the Assign Tag dialog box will be displayed.

Instrument Supply Line

Electrical Signal

Pnuematic Signal

Hydraulic Signal

-
r
e

Software Link

Capillary tube

Electromagnetic Signal

Mechanical Link

Leader

Figure 2-22 The instrument line symbols

In the Assign Tag dialog box, enter appropriate values in the Area and Loop Number edit boxes.
Next, select the TC - TEMPERATURE CONTROLLER option from the Type drop-down list
and choose the Assign button to close the dialog box. Figure 2-23 shows a typical instrumentation
loop.
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Figure 2-23 A typical instrumentation
loop

Adding Fittings

Fittings are used to connect pipe lines that have different sizes or shapes and they are also used
for regulating or measuring flow. You can add a fitting to a P&ID drawing from the Fittings tab
in the TOOL PALETTES - P&ID PIP. This tab contains symbols of Piping Fittings, Piping
Specialty Items, and Nozzles. For example, to add a concentric reducer, choose the Concentric
Reducer tool from the Piping Fittings area in the Fittings tab; you will be prompted to specify
the insertion point. Select a point on the line; the reducer will be placed at the specified position.

Adding the Off Page Connectors

The off page connectors are used to indicate the continuation of the process line from one
drawing sheet to another. To add an off-page connector, choose the Off Page Connector
tool from the Off Page Connectors and Tie-In Symbol area in the Non-engineering tab of
TOOL PALETTES - P&ID PIP; you will be prompted to specify the insertion point. Select
the endpoint of the line, as shown in Figure 2-24; the off page connector will be placed at the
specified location.

m

I — — J
N —— 1H

------ -

Figure 2-24 Placing the off-page connector

Connecting the Off Page Connectors

To connect two off page connectors, select any one of the off page connectors; a plus symbol
will be displayed on it, refer to Figure 2-25. Select the plus symbol; the Connect To option will
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be displayed near the cursor. Choose the Connect To option, refer to Figure 2-26; the Create
Connection dialog box will be displayed, as shown in Figure 2-27.

%
H \’_
@ _..¥
Connect To...

Plus symbol to be [
selected s

Figure 2-25 The plus symbol displayed on the off ~ Figure 2-26 Choosing the Connect To option
page connector

Create Connection a
Project drawings Preview

Select drawing to connect fo:
I Proiect 10

ny Offpage Connectars.

Note: OPCs must be connected to a line and the line number must be assigned
before they are available for selection.

[ Show all drawings

B Cancel Help

Figure 2-27 The Create Connection dialog box

In this dialog box, select the drawing to which the off page connector is to be connected from
the Project drawings area. Next, select the off page connector to be connected from the Select
Offpage Connector to Connect to table. Choose the OK button from the Create Connection
dialog box; the off page connectors will be connected.

VALIDATING THE DRAWING

You need to validate the drawing to detect the errors and to correct them. To do so, first

E’ you need to select the conditions to validate a P&ID. Choose the Validate Config tool

from the Validate panel in the Home tab; the P&ID Validation Settings dialog box will

be displayed, as shown in Figure 2-28. Select the check boxes under the P&ID objects and the

Base AutoCAD objects nodes and choose the OK button; the P&ID Validation Settings dialog
box will be closed.
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A PRUD Validation Settings - Project 1 x

Eror reporting
Report the following conditions as potential errors:

- P&ID objects A
pec mismatches

Nenteminating lines

Unconnected components

Fow direction conflicts

[ Omhaned annctations

H Unresolved off page connectors

3D Piping ©

Description
Size di ies between and lines.

Cancel Help

Figure 2-28 The P&ID Validation Settings dialog box

Checking for Errors

E‘. To run the checks for errors, choose the Run Validation tool from the Validate panel;

we  the validation process will start and the errors will be checked. The list of errors detected
H will be displayed in the VALIDATION SUMMARY palette, as shown in Figure 2-29. Click
on the error type in the VALIDATION SUMMARY palette; the drawing will zoom in where
you can see the error location. Next, to correct the individual errors, select the respective drawing
file node from the VALIDATION SUMMARY tree view. Now, choose the Revalidate Selected
Node button in the VALIDATION SUMMARY palette; the Validate Progress message box will
be displayed and errors will again be checked. You can also check for errors that are not corrected
and close the VALIDATION SUMMARY palette. This different type of errors are discussed next.

The Base AutoCAD Object Errors

This error occurs when AutoCAD object or block is inserted in the drawing instead of AutoCAD
P&ID component. You can ignore and erase a base AutoCAD object error. To do so, first you
need to expand the Base AutoCAD objects error node. Next, click on the error; the error will
zoom in the drawing.
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Now, you can ignore the base AutoCAD object error. To do so, right-click on it in the VALIDATION
SUMMARY palette; a shortcut menu will be displayed. Next, choose the Ignore option to ignore
the error. You can also delete the object by choosing the Erase option.

7 Current project: Project 1

=2 Validation Errors
B-FH a

Bl Mon-terminating lines

X Unlabeled Primary Line Segment
X Unlabeled Primary Line Segment
Base AutoCAD objects

X Polyline

Unconnected components

Lo -7

[] Den't display errors marked as ignored

Details

Fﬁm@mn
MNumber ignored |0

Total error number

»

> VALIDATION SUMMARY

Figure 2-29 The VALIDATION SUMMARY palette

The Size mismatch Errors

This type of error occurs when size of a line and its associated component do not match. This
condition is usually caused by manual changes in component properties. To correct the size
mismatch error, expand the Size mismatches node in the VALIDATION SUMMARY palette
and then click on the error; the error location will zoom-in in the drawing area. Next, manually
change the size of the component or the size of the line connected to it.

The Spec mismatch Errors

This type of error occurs when specification properties of the connected components do not
match. To correct the spec mismatch errors, zoom in the error location by clicking on the error
in the Spec mismatches node. Next, manually change the specifications of the line by invoking
the Assign Tag dialog box.

The Orphaned annotations Errors

This type of error occurs when the annotation tag of a component is moved away from the
associated component to more than the acceptable distance. To correct the orphaned annotation
error, expand the Orphaned annotations node in the VALIDATION SUMMARY palette. Next,
select the error to zoom its location in the drawing area. Next, drag the annotation and place
it nearer to the parent object. You can also right-click on the annotation and then choose the
Place from Parent option from the shortcut menu displayed. Figure 2-30 shows an orphaned
annotation and Figure 2-31 shows the annotation after correcting the error.
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P—001 P—001

Figure 2-30 Orphaned annotation Figure 2-31 Annotation after placing it
close to the component

The Unconnected Components Errors

This error occurs when the lines and components are not properly connected. To correct the
unconnected component error, select the error from the Unconnected components node; the
component in the drawing area will be zoomed in. Next, manually connect the component to
the line near it.

The Unresolved Off Page Connectors Errors

This error occurs when oft page connector in the drawing is not connected with the valid off
page connector of the other drawing. Select the error from the Unresolved off-page connectors
node in the VALIDATION SUMMARY palette; the oft page connector in the drawing area will
be zoomed in. Next, select and right-click on the oft-page connector in the drawing and choose
Offpage Connector > Connect from the shortcut menu displayed; the Create Connection
dialog box will be displayed, refer to Figure 2-27. Next, select the drawing to which you want to
connect the off page connector and then choose the OK button.

The Non-terminating lines Errors

This type of error occurs when the process line does not terminate with the valid terminator
such as endline component or endline symbol. Select the error from the Non-terminating lines
nodes to zoom it in the drawing area. Next, manually reconnect the line to the corresponding
object by moving its endpoint. You can also recreate the connection.

The Flow Direction Errors

This error will occur when the direction of flow of process line is incorrect. To correct a flow
direction error, click on the error under the Flow direction conflicts node; the error location
will zoom in the drawing area. Next, click on the direction arrow; the Flip Component grip will
be displayed. Click on this grip to flip the flow direction.

EDITING THE DRAWING

You can edit or modify a drawing while creating it or after it is created. The components of the
drawing such as equipment, valves, instruments, lines, and so on can be modified as per the
requirement. Various editing tasks are discussed next.
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Moving an Equipment

You can move or change the location of an equipment. To do so, first you need to select the
equipment by clicking on its border; the Move Component grip (square grip) will be displayed on
it. Select it and drag the equipment and click to place it at a new location, as shown in Figure 2-32.

Moving a Valve

To move a valve, first select it to display the Move Component grip. Next, click on the grip,
drag the valve along the horizontal or vertical line, and then click to place it at the new location.
You can move the valve which is on the horizontal line to the vertical line or vice-versa, refer
to Figure 2-33.

—~ BT —_ T
I Qrtho: 14375 < 0°

Figure 2-32 Moving an equipment Figure 2-33 Moving a valve from
horizontal line to the vertical line

Moving a Line

To move a line, first you need to select it; the stretch grip will be displayed on the line and the
components connected to the line will be automatically selected. Select it from the middle of
the line and drag it to the new location, as shown in Figure 2-34; the valves and the bubbles on
the line will be moved. But the equipment connected to the line will not move.

Figure 2-34 Moving a line using the stretch grips
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Editing a Line

To edit a line, choose the Edit tool from the Schematic Line panel in the Home tab; you will
be prompted to select a sline. Select a schematic line or a signal line from the drawing area;
you will be prompted to enter an option at the command prompt. The options available at the
command prompt are discussed next.

Attach

This option is used to attach the line to a component without physically connecting them. On
invoking this option, you will be prompted to select a component to attach to the line. Select an
equipment, valve, or any other P&ID component; you will be prompted to select an endpoint
on the schematic line. Select an endpoint on the line and press ENTER; the component will
be attached to the line.

Detach

This option is used to detach the attached line from the component. On invoking this option,
you will be prompted to select the endpoint on the schematic line which has been attached to
the source line. Select the attached endpoint on the line and press ENTER; the component will
be detached from the line.

Gap

This option is used to create a gap on the line without breaking it. On invoking this option, you
will be prompted to specify first gap point on the line. Specify the first gap point and move the
cursor upto the required distance, and select the second gap point; a gap will be created on the
line between the two specified points.

uNgap

This option removes the gap created on a line. On invoking this option, you will be prompted
to select a schematic line segment with a gap or gap symbol. Select a line segment with a gap
or gap symbol; the gap will be removed from the line.

Straighten

This option is used to straighten an inclined or a non-orthogonal line. On invoking this option,
you will be prompted to select a line segment to be straightened. Select the line segment; you
will be prompted to select an endpoint on the line to which the source line will be aligned. Select
the endpoint on the line; the line will be straightened in alignment with the endpoint.

Corner

This option is used to create a corner by dividing the line into two sides. On invoking this option,
you will be prompted to specify a point on the schematic line. Specify a point on the line; the
line will be divided into two sides and you will be prompted to specify the second point of the
corner. Move the cursor in a direction perpendicular to the line and select a point in the drawing
area; you will be prompted to specify a point on the side of the line to move it. Select a point
on one of the two sides; the selected side will be moved and aligned with the second point. As
a result, a corner will be created.
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Reverseflow
This option is used to reverse the direction of the schematic line. Invoke this option and press
ENTER; the direction of flow of the line will be reversed.

Break

This option is used to break the line into two segments. On invoking this option, you will be
prompted to select a break point. Select a point on the line; the line will be divided into two
segments and you will be prompted to select an additional break point. Press ENTER to exit.

Join

This option is used to join two line segments. On invoking this option, you will be prompted to
select one or more lines to join to the source line. Select a line segment that lies inline with the
source line; the line will be joined with the source line.

Link
This option is used to link data of two line segments. On invoking this option, the following
prompt will be displayed:

Select an sline segment to link to: Select a line

Sline segment data “?-?-?-?” will be deleted and segment will be linked to “?-?-?-?”. Continue?
[Yes/No]: Enter Yes’ to continue

Note
You can also choose the Yes option from the command prompt.

Unlink
This option unlinks the data link created between two line segments. On invoking this option,
the following prompt will be displayed:

eXit

This option is used to exit the command.

Grouping Lines
[“] You can group schematic lines together and assign tag to the group. To do so, choose the
Make Group tool from the Line Group panel in the Home tab; you will be prompted to
select the source schematic line to group additional schematic lines to it. Select the source line;
you will be prompted to select schematic lines to group. Select a single line or multiple lines
and press ENTER; the lines will be grouped together.
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Editing a P&ID Symbol

You can edit a P&ID symbol and also retain the original symbol by using the Edit Block tool. To
do so, choose the Edit Block tool from the P&ID panel in the Home tab; you will be prompted
to select a P&ID component to edit its block. Select an equipment, valve, or any other P&ID
component; the Block Editor tab will be invoked. The drawing area of the Block Editor tab has
a dull background and is called Authoring area. In this area, you can edit the existing entities or
add new ones to the block of a P&ID component. In addition to the Authoring area, the Block
Editor tab, BLOCK AUTHORING PALETTES, and Edit P&ID Object’s Block dialog box
will also be displayed. After editing the block, choose the Save Changes and Exit Block Editor
button from the Edit P&ID Object’s Block dialog box; the Block Editor will be closed and the
edited P&ID component will be displayed in the drawing area.

Substituting Components

You can substitute a valve or any other component of a drawing with another similar component.
For example, you can substitute a gate valve with a ball valve. To do so, first you need to select
the component to display the grips on it. Next, select the substitution grip (down arrow); the
Substitute with another Component palette containing valves will be displayed, as shown in
Figure 2-35. Select the ball valve symbol from the palette; it will replace the existing gate valve.

4

S X el e R
(=

Gl 1@l Ty Bl

Figure 2-35 The Substitute with another
Component palette containing valves

Converting AutoCAD Components into P&ID Symbols

You can add new symbols which are not available in TOOL PALETTES - P&ID PIP by creating
a block and converting it into a P&ID symbol. To convert a block into a P&ID symbol, first
you need to create a block by using the AutoCAD drawing tools. Next, select the component,
right-click on it and choose Convert to P&ID Object from the shortcut menu displayed; the
Convert to P&ID Object dialog box will be displayed, as shown in Figure 2-36. The tree view in
the dialog box shows a list of components arranged in groups. Expand the tree view by clicking
on the + sign adjacent to the required group and select the object from it. Next, choose the OK
button; the component will be converted into the selected P&ID object.
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Figure 2-36 The Convert to P&ID Object
dialog box

To add the converted component to the TOOL PALETTES - P&ID PIP, first you need to save
the current file. Next, open the tab in the TOOL PALETTES to which you want to add the
symbol. Choose the Design Center tool from the Palettes panel of the View tab. Choose the
Load button at the top left corner of the DESIGN CENTER palette; the Load window will be
displayed. Browse to the saved current file and choose on the Open button. Now, double-click
on the Blocks icon in the DESIGN CENTER palette; the saved block is displayed. Now, click
and drag the object and place it in the desired group in the TOOL PALETTES; the symbol will
be displayed in the TOOL PALETTES.

Adding Intelligence to the Custom P&ID Symbols

You can add more intelligence to the custom P&ID symbols that you want to add to the
TOOL PALETTES. The procedure to do so is illustrated below. Figure 2-37 shows the block of
a control valve which is to be added to the TOOL PALETTES.

Figure 2-37 The valve symbol block to be
added to the TOOL PALETTES
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To add the symbol shown in the Figure 2-37 to the TOOL PALETTES, make sure that the P&ID
PIP workspace is activated and the tool palette is loaded with P&ID PIP symbols.

Create the shape of the valve symbol, as shown in Figure 2-37 and convert it into a block with
the name control valve 1. Save the drawing by choosing the Save tool from the Quick Access
Toolbar. Convert this shape of the valve into P&ID symbol as discussed earlier. Next, click on the
Valves tab in the TOOL PALETTES - P&ID PIP to ensure that the custom symbol which is a
valve here gets added to the Valves tab of the TOOL PALETTES. Choose the Project Setup tool
from the Project Manager drop-down of the Project panel in the Home tab; the Project Setup
dialog box will be displayed, refer to Figure 2-38.

Database Setup

The database selection for a project s specified in the Project Setup Wizard at the f Set
purpose only.

® SGLite local database:
O SQL Server database

Share
PAID DWG Setings
Plart 30 DWG Settings SQL Server name:

Isometric DWG Settings
Ortho DWG Settings [ ]

Database rame prefc
[ ]

Authentication

Already have a project that youd like to convert from alocal database to a server database?

Learn More

Py = telp

Figure 2-38 The Project Setup dialog box

You can also invoke this dialog box by entering PROJECTSETUP in the command window or
by right-clicking on the project name node in the Project area of the PROJECT MANAGER
and, then selecting the Project Setup option from the flyout displayed.

In the Project Setup dialog box, expand the P&ID DWG Settings node by clicking on the + sign
and then choose, P&ID Class Definitions > Engineering Items > Inline Assets > Hand Valves.
Click on the Hand Valves sub-node to highlight it. Next, right-click to display a shortcut menu
and choose the New option; the Create Class dialog box will be displayed, refer to Figure 2-39.

Create Class *

Class Name:

Display Name of the Class:

| |
Cancel | [ Help

Figure 2-39 The Create Class dialog box
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Enter controlvalvel in the Class Name edit box; the specified name is also displayed in the
Display Name of the Class edit box (Note that the class name entered in the Class Name edit
box should not have any spaces in between the alphabets). Next, choose the OK button to exit
the dialog box; the specified class name will be listed and highlighted under the Hand Valves
sub-node. Also, the class name (controlvalvel) will be displayed next to the Class settings area.
Next, choose the Add Symbols button from the Symbol area; the Add Symbols - Select Symbols
dialog box will be displayed, refer to Figure 2-40.

A Add Symbols - Select Symbols X
Selected Drawings

Available Blocks Selected Blocks:

Preview Preview

No preview available No preview available

Help

Figure 2-40 The Add Symbols - Select Symbols dialog box

In this dialog box, choose the browse button next to the drop-down in the Selected Drawings
area; the Select Block Drawing dialog box will be displayed. In this dialog box, browse to the
file location and open it; the Add Symbols - Select Symbols will be displayed again with the list
of blocks contained in the drawing file in the Available Blocks list box. Select control valve 1
from the Available Blocks list box; it will be highlighted. Also a preview of the valve block will
be displayed in the Preview window available below the Available Blocks list box.

Next, choose the Add button; the block name will be displayed in the Selected Blocks list box
of the dialog box. Choose the Next button; the Add Symbols - Edit Symbol Settings dialog box
will be displayed. Enter control valve 1 in the Symbol Name edit box of the Symbol Properties
area. Choose the Yes option from the Auto Nozzle drop-down list and Flanged Nozzle Style
from the Auto Nozzle Style drop-down list of the Other Properties area. Next, choose the Finish
button; the Add Symbols - Edit Symbol Settings dialog box will be closed and the Project
Setup dialog box will be displayed again. Next, choose the Add to Tool Palette button from the
Project Setup dialog box; the Create Tool message box will be displayed with a message that
the control valve 1 tool has been added to the current tool palette. Choose the OK button to
exit the message box. Next, choose the Apply and then the OK button to exit the Project Setup
dialog box and add the control valve 1 symbol to the Valves area of the Valves tab.
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Editing the Properties of the Custom P&ID Symbol

Using the Project Setup dialog box, you can also edit the symbol settings, block settings, properties
like tag format, annotation style and so on. Consider that the newly created control valve 1 P&ID
symbol needs some editing as per the requirement. The steps to do various editing operations
on it are listed below.

Invoke the Project Setup dialog box and follow the path, P&ID DWG Settings > P&ID Class
Definitions > Engineering Items > Inline Assets > Hand Valves > controlvalvel. On doing
so, the controlvalvel will be displayed in the Class settings area and its preview will be displayed
in the Preview window in the Symbol area. Also, various properties related to the symbol will be
listed in the table in the Properties area of the dialog box. Choose the Edit Symbol button in
the Symbol area; the Symbol Settings dialog box will be displayed, refer to Figure 2-41.

A Symbol Settings g

| Symbol Properties -

Symbol Name control valve |

Block {control valve 1 =]
| General Style Praperties -]
Layer -~ Use Current -

Plotstyle ByColor
Lineweight - Use Current ----

| Other Properties -
Symbol Scal.. 1.0000
Scale on Ins.. No
ScaleMode  Uniform scaling
Rotate on In... No

Mimer on In... No

Tagging pro.. MNotatagged component
Join type Inline

AutoNozle  Yes

Auto Nozle... Flanged Nozzle Style

Concel | [t

Figure 2-41 The Symbol Settings dialog box

You can change various properties such as layer, color, linetype, symbol scale, tagging prompt,
join type by using the areas of this dialog box. Choose the OK button to exit the dialog box.
Choose the Edit Block button in the Symbol area; the Block Editor will be invoked displaying
the symbol of the custom block. You can use various tools of the Block Editor to make changes
in the shape, size and so on of the block and then exit the Block Editor by choosing the Close
Block Editor button from the Close panel of the Block Editor tab. In the Properties area of
the dialog box, you can set various properties related to the valve such as class name, model
number, description, size, spec. The name of the property will be listed in the Property Name
column of the table in the Properties area. You can also add a new property to the Property
Name list. To do so, choose the Add button from the Properties area; the Add Property dialog
box will be displayed, refer to Figure 2-42.
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() Selection List
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Cancel

Figure 2-42 The Add Property dialog box

Enter the property name in the Property name edit box; the specified name will also be displayed
in the Display name edit box. Next, choose a property type from the Choose a type area by
selecting the respective radio button. Next, choose the OK button; the dialog box is closed and
the property will be added to the Property Name column of the table. In the Tag format area
of the dialog box, a list box will be available displaying the Hand Valve Tag [Code-Number] by
default. You can add a new tag format to the list or modify the existing one. To add a new tag
format, choose the New button from the Tag format area; the Tag Format Setup dialog box

will be displayed, refer to Figure 2-43.

A Tag Fermat Setup

Class: controlvalvel

Format Mame: ||

Number of Subparts: |1 1%

Field

ENE RS

Delimiter

Mare ==

Help

Figure 2-43 The Tag Format Setup dialog box
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In this dialog box, enter the format name in the Format Name edit box. You can add subparts
to the tag format by entering the desired value in the Number of Subparts edit box either
manually or by using the spinner. The default value in the Number of Subparts edit box is
1. The information that a tag format will be carrying can be controlled by using the buttons
available in the list box of the dialog box, refer to Figure 2-43. The buttons in this list box are:
Select Class Properties, Select Drawing Properties, Select Project Properties, and Define
Expression. Using these buttons, you can set a new tag format for a class. After making all the
necessary changes, choose the OK button; the dialog box will be closed and the newly created tag
format will be listed and highlighted in the list box in the Tag format area of the Project Setup
dialog box. You can modify or delete the newly created tag format by choosing the Modify or
Delete button, respectively. You can also add, modify and change the annotation styles using the
options available in the Annotation area of the Project Setup dialog box. After making all the
necessary changes, exit the Project Setup dialog box by choosing Apply and then the OK button.

TUTORIAL

Tutorial 1

In this tutorial, you will create a P&ID, shown in Figure 2-44. You will create it by placing
equipments, instruments, and inline components and then connecting them with lines.
(Expected time: 2hr)
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Figure 2-44 P&ID for Tutorial 1

The following steps are required to complete this tutorial:

Start AutoCAD Plant 3D and then create a new project.
Create a new P&ID drawing.

Place equipments into the drawing.

Connect equipments using schematic lines.

an ow

TK—101

P-101B

P-101A
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Place valves on the lines connecting the components.
Add off-page connectors to the drawing.

Add tags to schematic lines.

Validate the drawing.

Save and close the drawing file.

FEae o

Starting AutoCAD Plant 3D and Creating a New Project
1. Double-click on the AutoCAD Plant 3D 2020 - English icon from the desktop of your
computer to start AutoCAD Plant 3D 2020.

2. Inthe PROJECT MANAGER, select the New Project option from the drop-down list avail-
able in the Current Project area; the Project Setup Wizard is displayed.

3. Enter CADCIM in the Enter a name for this project edit box and choose the Next button;
the Specify unit settings page is displayed.

4. Select the Imperial radio button, if not selected by default and then choose the Next button;
the Specify P&ID settings page is displayed.

5. Select the PIP option from the Select the P&ID symbology standard to be used list box,
if not selected by default and choose the Next button; the Specify Plant 3D directory
settings page is displayed.

6. Accept the default directory settings and choose the Next button; the Specify database
settings page is displayed.

7. Make sure the Single User - SQLite local database radio button is selected and choose the
Next button; the Finish page is displayed.

8. Choose the Finish button; you will notice that the CADCIM project is displayed in the
drop-down list available in the Current Project area of the PROJECT MANAGER. Also, a
node named CADCIM is created in the Project area.

Creating a New Drawing
1. Inthe PROJECT MANAGER, right-click on the P&ID Drawings node in the project tree
and then choose the New Drawing option; the New DWG dialog box is displayed.

2. Enter P&IDI1.dwg in the File name edit box and then specify the PID ANSI D -Color
Dependent Plot Styles.dwt template in the DWG template edit box.

3. Choose the OK button from the New DWG dialog box; the new P&ID drawing file is created
with the TOOL PALETTES displayed on the right side of the screen.

4. Choose the Workspace Switching button on the right-side of the Status Bar; a flyout is
displayed. Choose the PID PIP option from the flyout; the P&ID PIP workspace is invoked
and the TOOL PALETTES is loaded with the P&ID symbols. Note that, if Tool Palette is
not displayed, then choose the Tool Palettes button from the Palettes panel in the View
tab.
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Placing Equipment in the Drawing

1.

Choose the Vessel tool from the Vessel and Miscellaneous Vessel Details area in the
Equipment tab of the TOOL PALETTES - P&ID PIP; you are prompted to specify an
insertion point. Next, specify (13,5) as the insertion point of the vessel; you are prompted
to specify the scale factor.

Enter 1.5 as the scale factor; the Assign Tag dialog box is displayed. Enter 101 in the
Number edit box and make sure that the Place annotation after assigning tag check box
is selected. Next, choose the Assign button and specify the position of the annotation tag
near the vessel, as shown in Figure 2-45.

TK-101

Figure 2-45 P&ID afier placing the vessel
and the heat exchanger

Choose the TEMA type BKU Exchanger from the TEMA Type Exchangers area in the
Equipment tab of the TOOL PALETTES - P&ID PIP and place it at the point (7,5). Next,
assign tag E-101 to the heat exchanger. Figure 2-45 shows the P&ID after placing the vessel
and the heat exchanger.

Choose Horizontal Centrifugal pump from the Pumps area in the Equipment tab of the
TOOL PALETTES - P&ID PIP and place at the point (17,3). Next, assign tag P-101A to
the pump.

Similarly, place another horizontal centrifugal pump at the point (21,3). Next, assign the
tag P-101B to the pump. Figure 2-46 shows the P&ID after placing the centrifugal pumps.
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1o TK—101

go  Ge

P-101A P-101B

Figure 2-46 P&ID after placing two centrifugal
pumps

Connecting the Heat Exchanger and the Vessel
Now, you need to create lines connecting the equipment. Before doing that, you need to place
some nozzles at the required locations on the equipment.

1.

Choose Single Line Nozzle from the Nozzles area in the Fittings tab of the TOOL
PALETTES - P&ID PIP; you are prompted to select the asset to place nozzle.

Select the heat exchanger from the drawing sheet; the nozzle is attached to the cursor and
you are prompted to specify the insertion point.

Specify the insertion point, refer to Figure 2-47, and then specify the rotational angle as
90-degrees.

Next, you need to connect the heat exchanger and the vessel by drawing pipe lines. To do
so, you need to first make sure that the ORTHOMODE is turned on to draw straight lines.
Also, the Object Snap should be turned on for easy selection of the points.

Choose the Lines tab from the TOOL PALETTES and choose the Primary Line Segment
line type from the Pipe Lines area; you are prompted to select the start point.

Specify the start point on the newly created nozzle of the heat exchanger. Next, move the
cursor upward and enter 2 at the command prompt. Next, press ENTER.

Move the cursor horizontally toward right and specify the endpoint on the vessel; the line
connecting the vessel and the heat exchanger is created, refer to Figure 2-47.

Next, you need to assign a tag to the line.
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7. Choose the Assign Tag tool from the P&ID panel in the Home tab and select the previously
created line.

8. Press the ENTER key; the Assign Tag dialog box is displayed. Specify the following values
in the dialog box:

Size 8”
Spec CS150
Pipe Line Group.Service P-GENERAL PROCESS

Pipe Line Group.Line Number 1007

9. Clear the Place annotation after assigning tag check box. Choose the Assign button; the
tag is assigned to the line.

Note

@ You can also annotate the line with the assigned tag. 1o do so, you need to select the Place
annotation after assigning tag check box and then select the Pipeline Tag option from the
Annotation style drop-down list in the Assign Tag dialog box.

10. Invoke the Primary Line Segment tool from the Lines tab of the TOOL PALETTES and

connect the vessel to the nozzle located at the bottom of the heat exchanger. The line created
should be similar to the one shown in Figure 2-48.

—

In=artion point
of thenazzle | .\___H_j-"
-1
E-10 TE—-101
TK=101
Figure 2-47 Insertion point of the nozzle, Figure 2-48 Line connecting the vessel
and line connecting the vessel and the and the bottom nozzle of the heat exchanger

heat exchanger

11. Assign the tag 6”-CS150-P-1006 to the line.

12. Similarly, create lines connecting the other two nozzles (steam inlet and outlet nozzles)
of the heat exchanger, as shown in Figure 2-49. Next, assign tags 6”-CS150-P-2000 and
3”-CS150-SC-2002 to steam inlet line and condensate lines, respectively.

13. Choose the Secondary Line Segment tool from the Lines tab in the TOOL
PALETTES - P&ID PIP and create a loop on the line connecting the steam inlet nozzle of
the heat exchanger, as shown in Figure 2-50.
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E-1
Figure 2-49 The steam inlet line and Figure 2-50 Loop created on line connecting
condensate line of the heat exchanger the steam inlet nozzle

Connecting the Vessel to Pumps
Next, you need to create pipe lines connecting the vessel and pumps.

1. Invoke the Primary Line Segment tool from the Lines tab in the TOOL PALETTES - P&ID PIP
and specify the start point at the bottom of the vessel, as shown in Figure 2-51.

2. Connect the line to the horizontal nozzle of the pump tagged P-101B. The line created
should be similar to the one shown in Figure 2-52. In this tutorial, this line is referred as
inlet line of the pump.

—=H

] TK—101
Paoint to be GU
selected P—101A P-101B
Figure 2-51 Point to be selected on the vessel Figure 2-52 Line connecting the vessel and
the pump

3. Assign tag 10”-CS150-P-1004 to the line.

4. Create a line connecting the previously created line to the horizontal nozzle of the pump
tagged P-101A, refer to Figure 2-53. Assign the tag 10”-CS150-P-1004 to the line.
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P—101A P-1018B

Figure 2-53 Line connecting the horizontal nozzle of the pump
lagged P-1014

5. Invoke the Draw tool from the Schematic Line panel in the Home tab; you are prompted
to specify the start point of the line.

6. Specify the start point on the vertical nozzle of the pump tagged P-101A, and then create
a line, as shown in Figure 2-54.

7. Assign tag 8”’-CS150-P-1012A to the line.

8. Next, connect the vertical nozzle of the other pump to the previously created line, refer to
Figure 2-55. Assign the tag 8”-CS150-P-1012B to the line.

—{Jo

P—101A P-101B
P—101A P-101B
Figure 2-54 Line connecting the vertical nozzle Figure 2-55 Line connecting another pump and
of the pump previously created line

Note that in this tutorial, the newly created line is referred as outlet line of the pump.
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Creating the Remaining Lines Connecting the Vessel

1.

Invoke the Primary Line Segment tool and specify the start point as (4,13). Next, move the
cursor horizontally toward right and specify the endpoint on the vessel; the line is created,
as shown in Figure 2-56. Note that this line will be referred as feed line in this tutorial.

Next, assign tag 12”’-CS150-P-1001 to the line.

Choose Secondary Line Segment from the Lines tab in the TOOL PALETTES - P&ID
PIP and create the loop, as shown in Figure 2-57.

Figure 2-56 Line connected to the vessel — Figure 2-57 Loop created on the previous line

4. Create another primary line by specifying the start point at 4,17. It should be similar to the

line shown in Figure 2-58. Assign tag 4”°-CS150-P-1000 to the line.

This line is referred as reflux line.

Figure 2-58 Reflux line connected to the
vessel

Next, you need to create a line originating from the top of the vessel.
Invoke the Primary Line Segment tool and specify the start point on the top of the vessel.
Move the cursor upward and enter 1 at the command prompt. Next, press ENTER.

Move the cursor horizontally toward right and create a line, as shown in Figure 2-59.
Assign the tag 12”-CS150-P-1006T to the line.

Invoke the Secondary Line Segment tool and create a line, as shown in Figure 2-60.
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Figure 2-59 Line drawn from the top of Figure 2-60 Drawing the secondary line
the vessel connecting the previous line

Addmg Valves to the P&ID
Choose the Control Valve tool from the Control Valve area of the Valves tab of the TOOL
PALETTES; you are prompted to pick the insertion point.

2. Choose the Change body or actuator option from the command prompt to invoke the
Control Valve Browser dialog box. Note that if you are adding a control valve for the first
time, the Control Valve Browser dialog box will be displayed by default.

3. Select the Globe Valve option from the Select Control Valve Body tree view and Diaphragm
Actuator from the Select Control Valve Actuator tree view and then choose the OK button.

4. Insert the control valve on the feed line, as shown in Figure 2-61.

5. Specify the position of the annotation balloon near the control valve; the Assign Tag dialog
box is displayed.

6. Enter the values given next in this dialog box and then choose the Assign button.

Area 01
Type CvV
Loop Number 1001

7. Similarly, place a control valve on the steam inlet pipe of the heat exchanger, as shown in
Figure 2-62. Note that you need to specify Butterfly Valve and Diaphragm Actuator as the
valve body and actuator, respectively.

8. Enter the following values in the Assign Tag dialog box:

Area 01
Type CvV
Loop Number 1002
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Figure 2-61 Location of the control valve  Figure 2-62 Location of the control valve on
the steam inlet line

9. Choose Gate Valve from the Valves area in the Valves tab of the TOOL PALETTES - P&ID

PIP, and place it at two locations, as shown in Figure 2-63.

Note
On inserting a valve, an annotation is displayed by default next to it. To avoid this, you need to
hide objects. To do so, right-click on the annotation and choose Isolate> Hide Objects.

10. Next, choose Butterfly Valve and place it at the location shown in Figure 2-63.

11. Similarly, place two gate valves and a butterfly valve on the pipe which is connected to the
heat exchanger, as shown in Figure 2-64.

Figure 2-63 Location of the gate valve and  Figure 2-64 Location of gate valves and the
butterfly valve on the line connected to the  buiterfly valve
vessel

12. Next, create two secondary lines connecting the steam inlet pipe, as shown in Figure 2-65.

13. Choose Plug from the Piping Fittings area in the Fittings tab of the TOOL PALETTES -
P&ID PIP, and then place it at the endpoints of the secondary lines, refer to Figure 2-65.

14. Next, delete the arrows on the secondary lines and place gate valves, as shown in Figure 2-66.
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Figure 2-65 Secondary lines with plugs placed Figure 2-66 Gate valves placed on the
at their endpoints secondary lines

15. Invoke the PROPERTIES palette of the gate valves by double-clicking on them.

16. Select the Gate Valve Closed Style option from the Graphical style drop-down list of the
Styles area, refer to Figure 2-67; the gate valve is closed, as shown in Figure 2-68.

@
1002,

| P&ID - VV
Class Gate Valve
| Tag - | g g
Tag HA-108 A L
| Styles - |
Graphical style |Gate Valve Clo... | - |
| General Gate Valve Closed Style | -

Description Gate Valve Style L I ||

Figure 2-67 Sclecting the Gate Valve  Figure 2-68 The graphical style of gate valves
Closed Style option from the Graphical — changed to the closed type
style drop-down list

17. Similarly, create secondary lines and place the plugs and gate valves at the locations shown

in Figure 2-69.
C
.

Gate valves to be placed

Figure 2-69 Locations of the secondary lines
and gate valves
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Note
@ If requared, you can change the attachment point of the Plug by choosing the Point option from

the command prompt.

Adding Instruments to the P&ID

Next, you need to add instruments to the P&ID.

1.

Choose the Restriction Orifice tool from the Primary Element Symbols (Flow) area of the
Instruments tab in the TOOL PALETTES - P&ID PIP; you are prompted to specify the
insertion point.

Place the restriction orifice on the pipe which is connected to the vessel, as shown
in Figure 2-70.

Enter the values given next in the Assign Tag dialog box and place the annotation near the
orifice.

Area 01
Type FE-FLOW ELEMENT
Loop Number 1001

Similarly, place another restriction orifice on the steam inlet pipe of the heat exchanger,
refer to Figure 2-71. Next, enter the following values in the Assign Tag dialog box:

Area 01
Type FE-FLOW ELEMENT
Loop Number 1002

—

1_ T P—N?Tﬂ—

Figure 2-70 Location of the orifice Figure 2-71 Location of the orifice on the steam
inlet line of the heat exchanger

Next, you need to create instrumentation line connecting the orifice and the control valve.

Choose the Electric Signal tool from the Instrument Lines area in the Lines tab of the
TOOL PALETTES - P&ID PIP.

Specity the start point on the orifice located on the pipe connected to the heat exchanger
and move the cursor upward upto a distance of 1.5. Next, click to specify the endpoint.
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You need to make sure that the Object Snap and Object Snap Tracking options are activated

in the Status Bar.

7. Move the cursor toward right and click when the cursor snaps to the mid point of the control

valve, as shown in Figure 2-72.

8. Next, move the cursor downward and specify the endpoint on the control valve, refer to

Figure 2-73.
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Figure 2-72 Snapping to the midpoint of the Figure 2-73 Specifying the endpoint of the

control valve electric signal line

9. Similarly, create an electrical signal on the pipe connecting the vessel, as shown in Figure 2-74.
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Figure 2-74 Electric signal created on the
feed line

10. Choose Primary Accessible DCS from the General Instruments area of the Instruments

tab in the TOOL PALETTES - P&ID PIP.

11. Place the instrument symbol on the electric signal line, as shown in Figure 2-75; the Assign

Tag dialog box is displayed.
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12. Enter the values given next in the Assign Tag dialog box and choose the Assign button.

Area 01
Type FC - FLOW CONTROLLER
Loop Number 1002

13. Similarly, place another Primary Accessible DCS on the electric signal connected to the
feed pipe, refer to Figure 2-76.
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Figure 2-75 Position of the Primary Figure 2-76 Position of another Primary
Accessible DCS Accessible DCS on the electric signal line
of the feed line

.
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14. Assign tag 01-FC-1001 to the instrument.

Placing Valves and Fittings on the Lines Connecting the Pumps
Next, you need to place valves and fittings on the lines connecting the pumps.

1. Choose Eccentric Reducer from the Piping Fittings area in the Fittings tab of the TOOL
PALETTES - P&ID PIP and place it on the line connecting the horizontal nozzle of the

pump, as shown in Figure 2-77.

2. Place a gate valve on the same line, refer to Figure 2-78.
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10"x107

Figure 2-77 An eccentric reducer placed on Figure 2-78 A gate valve placed on the
the line connecting the first pump line connecting the first pump

3. Choose the Assign Tag button from the P&ID panel and select the line connected to the
reducing end of the eccentric reducer and press ENTER; the Assign Tag dialog box is
invoked.

4. Modity the size of the line to 8”, refer to Figure 2-79 and choose the Assign button from
the dialog box.

5. Similarly, place an eccentric reducer and a gate valve on the pipe connecting the other
pump, as shown in Figure 2-80.

Figure 2-79 Modified size of a line Figure 2-80 A gate valve and an eccentric reducer
placed on the line connecting the second pump

6. Change the size of the pipe line connecting the reducing end of the eccentric reducer to 8”.

7. Place Check Valves and Gate Valves on the outlet lines of the two pumps, refer to
Figures 2-81 and 2-82.
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P—101A P—1018

Figure 2-81 Check valve and gate valve Figure 2-82 Check valves and gate valves
placed on the outlet line of the first pump placed on outlet lines of both the pumps

Next, you need to place a pressure relief valve on the pipe connecting the top nozzle of the vessel.

8. Choose Pressure Relief Valve from the Relief Valves area in the Instruments tab of the
TOOL PALETTES - P&ID PIP.

9. Place the pressure relief valve on the secondary line of the line connecting the top nozzle
of the vessel, as shown in Figure 2-83, and give the required parameter in the Assign Tag
dialog box.

10. Place a gate valve on the same line, as shown in Figure 2-84.

PSv
PSV ]
AS 1002
N

Figure 2-83 Location of the pressure relief — Figure 2-84 Location of the gate valve
valve

Adding Off Page Connectors

1. Choose the Off Page Connector tool from the Off Page Connectors and Tie-In Symbol
area of the Non-engineering tab of the TOOL PALETTES - P&ID PIP; you are prompted
to specify the insertion point.
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2. Place the off page connector at the endpoint of the line connecting the pumps, as shown
in Figure 2-85.

3. Similarly, place off page connectors at the locations shown in Figures 2-86 and 2-87.

|
\
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Figure 2-85 Off page connector placed at Figure 2-86 Off page connectors placed at
the endpoint of the pump outlet line the endpoints of the feed line and reflux line

4. Choose the Utility Connector tool from the Off Page Connectors and Tie-In Symbol area
of the Non-engineering tab of the TOOL PALETTES - P&ID PIP and place then at the
locations shown in Figures 2-87 and 2-88.

e — E
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=
Figure 2-87 Location of utility connector and Figure 2-88 Utility connectors placed at
off page connector the endpoints of the steam inlet line and

the condensate line

Validating the Drawing
1. Choose the Validate Config button from the Validate panel in the Home tab; the P&ID
Validation Settings dialog box is displayed.

2. In this dialog box, expand the P&ID objects node and clear the Unresolved off-page
connectors check box. Similarly, expand the 3D Model to P&ID checks node and clear all
the check boxes under it. Next, choose the OK button to close the dialog box.
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Note
In this tutorial, the off page connectors are not validated because they are not connected to any
other P&ID.

3. Run validation process by choosing the Run Validation tool from the Validate panel; the
VALIDATION SUMMARY palette is displayed with a tree list of errors in the drawing.

4. Right-click on any error in the VALIDATION SUMMARY palette and choose Ignore to
ignore the error. Similarly, ignore all the errors and exit the VALIDATION SUMMARY
palette.

Saving the Drawing
1. Choose the Save option from the Application menu or choose File > Save in the menu bar
to save the drawing file c02tut01.dwg.

2. Choose Close > Current Drawing from the Application Menu to close the drawing file.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. You can substitute a component by invoking the

2. Youneed touse to indicate the continuation of the process line from one drawing
sheet to the another.

3. You can specify the control valve body and the actuator in

4. To convert an AutoCAD component into a P&ID symbol, you need to choose the
option.

5. You should select the P&ID Drawings node in the Project tree and then choose the New
Drawing button to create a new P&ID file. (T/F)

6. When you move a line, the equipment connected to the line also moves with the line. (1/F)

7. When you move a line, the inline components such as valves and balloons also move with
the line. (T/F)

8. If the diameter of the line on either side of the reducer is changed, the reducer will be
reoriented. (T/F)

9. You can add converted AutoCAD component to the TOOL PALETTE - P&ID PIP by
clicking and dragging it into the TOOL PALETTE. (T/F)

10. A nozzle will be placed automatically when you connect a line to an equipment. (T/F)
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Review Questions

Answer the following questions:

1.

9.

The dialog box is displayed if you choose the Control Valve tool for the first
time.

A project file is a file.
You can edit a P&ID symbol using the tool.

The option in the Edit tool is used to attach a line to a component without
physically connecting to it.

The option in the Edit tool is used to divide a line into two.
The Make Group tool is used to group

The button in the VALIDATION SUMMARY palette is used to run validation
on selected node.

You can place a symbol from the PID ISO Tool palette even while working in PIP standard
file. (T/F)

The PROJECT MANAGER is used to manage the project files only. (1/F)

10. You can activate more than one project at a time. (T/F)

EXERCISE

Exercise 1

In this exercise, you will create the P&ID shown in Figure 2-89. (Expected time: 30 min)
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Figure 2-89 P&ID for Exercise 1

Answers to Self-Evaluation Test
1. Substitution palette, 2. Off-Page Connector, 3. Control Valve Browser, 4. Convert to P&ID
object, 5. T,6. F, 7. T,8.T,9. T, 10. T



